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1 Introduction

PyXRD  is  a  computer  model  developed  in  Python  for  the  simulation  of  1-dimensional  X-ray
diffraction patterns for mixed-layer minerals. It has been developed keeping a multi-specimen full
profile  fitting  strategy  in  mind.  It  allows  for  (semi-)quantification  of  mixed-layer  phases  by
combining  several  observed  XRD patterns  and  can  perform automatic  parameter  refinements
using several aglorithms.

This document provides for a general overview of the theoretical background on which this model
is  based,  an  overview of  the  actual  implementation  (code-wise)  and  instructions  on  how the
general user interface (GUI) written in GTK can be used to create and modify models.

For more detailed information we kindly refer to the source documentation and if that is failing, the
source code itself.

If any mistakes are discovered in this document please inform me at mathijs.dumon@ugent.be

2 License
                                     PyXRD                                     
    A python implementation of the matrix algorithm developed for the X-ray    
        diffraction analysis of disordered lamellar structures
         
                     Copyright (c) 2013-2014, Mathijs Dumon                     

       This software is licensed under a BSD-2 Clause ("FreeBSD") License,      
   except for the mvc module, which is a derived work from the pygtkmvc library 
             and is accordingly licensed under a GNU LGPL 2 license.
        You should have received a copy of the GNU Library General Public       
       License along with this library; if not, write to the Free Software      
               Foundation, Inc., 51 Franklin Street, Fifth Floor,               
                           Boston, MA 02110-1301 USA                           

################################################################################
All rights reserved - BSD-2-Clause ("FreeBSD") License.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice,
  this list of conditions and the following disclaimer.

- Redistributions in binary form must reproduce the above copyright notice,
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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3 Installation

3.1 Windows

As of PyXRD v0.6.2 there are two options for windows users: (i) either manually install  all  the
dependencies and PyXRD or (ii)  use a custom installer  which will  install  PyXRD and all  of  its
dependencies for you.

Note that when using the bundled installer, DEAP is not installed. You will still need to follow the
instructions in section 3.1.3 

3.1.1 Bundled installer

Download and run the bundled installer:

https://github.com/mathijs-dumon/PyXRD/releases/download/v0.6.2/PyXRD-0.6.2-win32-
bundle.exe

For most of the dependencies this does not require input from your side. However, for the Numpy
and Scipy libraries there is currently no easy way to completely automate the installation. As a
result, you will have to click 'Next' and/or 'Finish' a few times to complete the installation for these
libraries.

Note that this is still an experimental feature. If you encounter problems, please report them by e-
mail (mathijs.dumon@ugent.be) and continue by following the instructions for manual installation
below.

3.1.2 Manual install

The installation  is  a  bit  lengthy  because  PyXRD depends  on  a  number  of  third-party  python
modules.  Work has started to create a unified installer,  but for now you'll  have to install  them
manually. These are the dependencies (more recent versions should also work, except for python
which needs to be version 2.7):

• Python: http://www.python.org/ftp/python/2.7.8/python-2.7.8.msi

• PyGTK: http://ftp.gnome.org/pub/GNOME/binaries/win32/pygtk/2.24/pygtk-all-in-one-
2.24.2.win32-py2.7.msi

• Numpy: http://sourceforge.net/projects/numpy/files/NumPy/1.7.0/numpy-1.7.0-win32-
superpack-python2.7.exe/download

• Scipy:  http://sourceforge.net/projects/scipy/files/scipy/0.14.0/scipy-0.14.0-win32-superpack-
python2.7.exe/download

• Matplotlib: https://downloads.sourceforge.net/project/matplotlib/matplotlib/matplotlib-
1.2.1/matplotlib-1.2.1.win32-py2.7.exe

• Pyparsing: http://sourceforge.net/projects/pyparsing/files/pyparsing/pyparsing-
2  .  0  .  3  /pyparsing-  2  .  0  .  3  .win32-py2.7.exe/download
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• Setuptools: https://bootstrap.pypa.io/ez_setup.py

1. Download the script somewhere you can find it (e.g. the desktop)

2. Open a command line as administrator
(Start button → Search → enter 'cmd.exe' → right-click the command line icon and 
select 'Run as adiministrator')

3. Enter the following command (replace the path to ez_setup to where you have 
downloaded it):
C:\Python27\python.exe c:\users\myusername\Desktop\ez_setup.py

This assumes you have installed python in C:\Python27 (the default location), if not 
change the command accordingly.

Finally download and install PyXRD:
https://github.com/mathijs-dumon/PyXRD/releases/download/v0.6.1/PyXRD-0.6.1.win32.exe

3.1.3 Installation of DEAP

You can optionally install DEAP which will provide evolutionary refinement algorithms:

1. Open a command line as administrator
(Start button → Search → enter 'cmd.exe' → right-click the command line icon and select 
'Run as adiministrator')

2. Enter the following command: 
C:\Python27\Scripts\easy_install.exe deap
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3.2 Linux

Installation on linux should be straightforward, first install Python 2.7 and PyGTK:

• Debian/Ubuntu/...
sudo apt-get install python python-gtk2

• Fedora/Red Hat/... (untested)
sudo yum install python python-gtk

• OpenSuSE (untested)
sudo yum install python python-gtk

Then you can choose to either install the dependencies from your package manager repositories
or using pip or easy_install. Usually it is preferable to use the binaries from the package manager
as you will not need to install them by hand. The dependencies are:

• Numpy >= 1.7.0

• Scipy >= 0.14.0

• Matplotlib >= 1.2.1

• Pyparsing >= 2.0.4

• Setuptools

And the corresponding commands would be:

• Debian/Ubuntu/...
sudo apt-get install python-numpy python-scipy python-matplotlib

• Fedora/Red Hat/... (untested)
sudo yum install python python-gtk python-numpy python-scipy  python-matplotlib

• OpenSuSE (untested)
sudo yum install python python-gtk python-numpy python-scipy  python-matplotlib

Once this has been completed, open a terminal and enter these commands:

sudo easy_install pip
pip install --user 'pyxrd>=0.6.2'

This will install everything under your '~/.local' folder. To run PyXRD type in the following:

~/.local/bin/PyXRD

or make a shortcut to this command.
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4 Theoretical background

4.1 General mathematical formalism

The mathematical formalisms on which PyXRD is based is described in a number of articles and
books published over the years. Relevant references can be found at the end of this section. Below
an  overview will  be  given  of  the  different  parts  of  the  general  matrix  formalism.  This  matrix
formalism allows to calculate the diffraction pattern of a single mixed-layer mineral:

I x=ℜTr {F⋅W⋅[N⋅I+R ]} (eq. box 4.1)

in which:

Ix the diffracted intensity
F the structure factor matrix (see chapter 4.2); 
W the weight fraction matrix (see chapter 4.6);
N average coherent scattering domain size (CSDS) (see chapter 4.4)
I the identity matrix;
R is defined as:

R=∑
n=1

N max

(2⋅Qn
⋅∑
m=n+1

N max

((m– n)⋅q(n))) (eq. box 4.2)

in which:
Q the phase difference matrix (see chapter 4.3);
q(n) the  coherent  scattering  domain  size  (CSDS)  distribution  function,

yielding  the  relative  chance  to  encounter  'n'  coherently  scattering
layers (see chapter 4.4)

Nmax the maximum number of layers in the CSDS

In the following sections, the calculation of each of these matrices and functions is explained in
more detail.

4.1.1 Length of the reciprocal vector: s

The length of the reciprocal vector (commonly denoted as s⃗ ) can be expressed as:

s= 2⋅sinθ
λ

(eq. box 4.3)

in which:

θ the angle of the incident X-ray bundle
λ the wavelength of the X-ray waves

It relates with Bragg's formula like this:

2⋅d⋅sin(θ)=n⋅λ
2⋅sin(θ)

λ
=
n
d
=s

(eq. box 4.4)

4.2 Calculation of the structure factor matrix F

4.2.1 General

The actual size of the F and Q matrices depends on the Reichweite of the model. Therefore this
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section is split in two parts: first the setup of the structure factor matrix for R0 and R1 models is
explained, and  then it is explained how that matrix can be scaled to match the higher Reichweite
models.

i. Layout for R0 and R1 models

The structure factor matrix F then has the following definition:

F=[
F1F 1

* F2 F1
* ... F n F1

*

F 1F 2
* F2 F2

* ... F nF 2
*

. .. ... ... ...
F 1F n

* F 2 Fn
* ... F nF n

*] (eq. box 4.5)

in which:

Fn the structure factor for the n-th component (see 4.2.2) 
Fn* its complex conjugate

The complete structure factor matrix F can be constructed from simpler matrices. First we create a
1D matrix Fa containing the structure factors for each component:

F a=[F1 F 2 ... Fn ] (eq. box 4.6)

After this we create another 1D matrix Fb which is the transpose-conjugated form of matrix Fa:

F b=F a
*T
=[

F 1
*

F 2
*

. ..
F n
*] (eq. box 4.7)

The structure factor matrix F can then be constructed by multiplying matrices Fb with Fa:

F=F b⋅Fa=F a
*T
⋅Fa

F=[
F 1
*

F 2
*

. ..
F n
*]⋅[F1 F 2 ... F n]

F=[
F1F 1

* F2 F1
* ... F n F1

*

F 1F 2
* F2 F2

* ... F nF 2
*

. .. ... ... ...
F 1F n

* F 2 Fn
* ... F nF n

*]
(eq. box 4.8)
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ii. Scaling for higher Reichweite models

For models with R > 1 the matrix needs to be of size GR. To accomplish this, each pair of structure
factors Fi⋅F j

*  is replaced with a sub-matrix of size GR-1 of the form:

F ij=[
F iF j

* F i F j
* ... F i F j

*

F iF j
* F i F j

* ... F i F j
*

... ... ... ...
F iF j

* F i F j
* ... F i F j

*] (eq. box 4.9)

With other words, each pair of structure factors is replaced with a 'sub-matrix' of size GR-1 in which
each element is a duplicate of the replaced pair of structure factors.

4.2.2 Structure factor Fn for a component

The structure factor characterizing the X-ray scattering by an infinite,  three-dimensional atomic
motif can, in general, be written as:

F hkl (s)=∑
m

f m(s)⋅exp(2⋅π⋅i⋅(
h⋅xm

a
+
k⋅ym
b

+
l⋅zm
c

)) (eq. box 4.10)

in which:

m the number of atoms in the motif of the component
fm(s) the scattering factor for atom 'm'
xm, ym, zm the position of atom 'm' along the X, Y and Z axes of the motif (in nm)
h, k, l the miller indices of the reflection being calculated
a, b, c unit cell dimensions along the X, Y and Z axes of the motif (in nm)
s the length of the reciprocal vector (see chapter 4.1.1)
i the unreal number

However, since we are only interested in 00l-reflections, the h and k terms can be dropped
and the structure factor for this 1-dimensional atomic motif can be written as:

F n=∑
m

f m(s)⋅exp(2⋅π⋅i⋅
l⋅zm
c

) (eq. box 4.11)

According to Bragg's law, we can write (also see chapter 4.1.1):

2⋅sin(θ)
λ

=
n
c
=s (eq. box 4.12)

Combining the above two relations and setting n=1 and l=1, we can write:

F n=∑
m

f m(s)⋅exp(2⋅π⋅i⋅zm⋅s) (eq. box 4.13)

in which:

m the number of atoms in the motif of the component
fm(s) the scattering factor for atom 'm' (see chapter 4.2.3)
zm the position of atom 'm' along the Z axis of the motif
s the length of the reciprocal vector (see chapter 4.1.1)
i the unreal number (= √(−1) )

The complex conjugate of the structure factor is (see chapter 4.2):
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F n
*
=∑

m

f m(s)⋅exp (−2⋅π⋅i⋅zm⋅s) (eq. box 4.14)

This exponential relation can be transformed using Euler's formula into the sine and cosine form:

F n=∑
m

f m(s)⋅[cos (2⋅π⋅i⋅zm⋅s)+i⋅sin(2⋅π⋅i⋅zm⋅s)] (eq. box 4.15)

The complex conjugate of this formula can then be written as:

F n
*
=∑

m

f m(s)⋅[cos (2⋅π⋅i⋅zm⋅s)−i⋅sin(2⋅π⋅i⋅zm⋅s)] (eq. box 4.16)

4.2.3 Atomic scattering factor for a single atom: fm

The atomic scattering factor for a single atom is calculated using the Cromer-Mann coëfficiënts as
published in Waasmaier and Kirfel (1995). The Debye constants are set to:

0 for neutral atoms
2 for anions
1.5 for cations

The atomic scattering factor is calculated as follows:

f m(s)=Pm⋅[c+∑
i=1

5

(ai⋅exp (−bi⋅
s2

2⋅10
))]∗exp (−Bm∗s

2
) (eq. box 4.17)

in which:

Pm the  number  of  atoms per  unit  cell  at  this  z  location  (needed  due  to  the
projection on the Z-axis)

c constant of the exponential approximation of the scattering factor
ai the i-th a factor of the exponential approximation of the scattering factor
bi the i-th b factor of the exponential approximation of the scattering factor
s the length of the reciprocal vector (see chapter 4.1.1)
Bm the Debye constant for that atom

The factor 10 in the exponential part of the summation is there to convert the units of the reciprocal
vector s from nanometer to Ångstrom (factor 10).

4.3 Calculation of the phase factor matrix Q

4.3.1 General

As explained in section 4.2.1, the actual size of the F and Q matrices depends on the Reichweite
of the model. This section is also split in two parts: first the setup of the phase factor matrix for R0
and R1 models is explained, and then it is explained how that matrix can be scaled to match the
higher Reichweite models.

i. Layout for R0 and R1 models

The phase factor matrix Q is the Hadamard product (element-wise product, not the regular matrix
multiplication) of two other matrixes:

Q=[ϕ]∘P (eq. box 4.18)

of which the first term can be defined as follows:
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[ϕ]=[
ϕ11 ϕ12 ... ϕ1n
ϕ21 ϕ22 ... ϕ2n
. .. ... ... ...
ϕn1 ϕn2 ... ϕnn

] (eq. box 4.19)

in which:

φij the phase difference between the i-th and j-th components

The matrix  P contains the probability parameters.  Its  calculation  is  detailed in  chapter  4.6 for
different values of R and will not be discussed in further detail here.

ii. Scaling for higher Reichweite models

For models with R > 1 the  [ϕ]  matrix needs to be of size GR. To accomplish this, each phase
difference [ϕij]  is replaced with a sub-matrix of size GR-1 of the form:

[ϕij]=[
ϕij ϕij ... ϕ ij

ϕij ϕij ... ϕ ij

... ... ... ...
ϕij ϕij ... ϕ ij

] (eq. box 4.20)

With other words, each phase difference is replaced with a sub-matrix of size GR-1 in which each
element is a duplicate of the replaced phase difference.

4.3.2 Phase difference between the i-th and j-th components: φij

The phase difference depends on the distance between the components.  If  we define the i-th
component as the one preceeding the j-th component, the phase difference depends on the basal
spacing of that i-th component (and not of the j-th component):

φ=e2⋅π⋅s⋅(d 001⋅i−π⋅δ001⋅s) (eq. box 4.21)

in which:
s the length of the reciprocal vector (see chapter 4.1.1)
i the unreal number (= √(−1) )
d001 the basal spacing of the i-th component (nm)
δ001 the variation in the basal spacing of the i-th component (nm)
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4.4 Calculation of the coherent scattering domain size (CSDS) distribution
function q

Several  function  types  have  been  proposed  in  the  past.  Their  definitions  are  detailed  below.
Currently in the model only a generic log-normal distribution and the log-normal distribution as
proposed in Drits et al. (1997) are implemented.

In general, the average CSDS can be calculated from whatever CSDS distribution function is used:

N̄=∑
n=1

Nmax

n⋅q(n) (eq. box 4.22)

4.4.1 Ergun model (not implemented)

On of the first CSDS distributions proposed is that of Ergun (1970):

q(n)=exp (2−N
δ

) (eq. box 4.23)

in which:

n the CSDS value of interest
δ the mean defect-free number of layers

However, this simple model is not used often anymore and has been replaced by a log-normal
CSDS distribution.

4.4.2 Log-normal models

The log-normal models assume a log-normal distribution of CSDS values. The basic definition is:

q(n)=√ 2⋅π

β
2
⋅n2⋅exp(−( log (n)– (α))2

2⋅β2 ) (eq. box 4.24)

in which:

n the CSDS value of interest
α the mean of the probability density function, defined as:

α=a1⋅log (N̄)+a2

in which a1 and a2 are empirical constants and N is the average CSDS.

β² the variance of the probability density function, defined as:
β

2
=b1⋅log (N̄)+b2

in which b1 and b2 are empirical constants and N is the average CSDS.
This model is implemented in PyXRD, together with a model which has pre-set values for the a1,
a2, b1 and b2 parameters (according to Drits et al. (1997)):

a1 = 0.9485
a2 = 0.0170
b1 = 0.1032
b2 = 0.0034
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4.5 Preferred orientation

A correction for preferred orientation of phases is applied. The basics for these corrections were
laid by Reynolds (1986) and the importance of these corrections has recently been reiterated upon
by  (Dohrmann  et  al.,  2009).  The  effect  of  preferred  orientation  is  grouped  into  the  Lorentz-
Polarisation factor:

S=√S1
2+S2

2

4

Q=
S

√8⋅sin (θ)⋅σ*

ψ=erf
(Q)⋅√2⋅π

2⋅σ *⋅S
−2⋅sin(θ)⋅(1−e−Q2

S2 )
Ξ=

1+cos2(2θ)
sin(2θ)

⋅ψ
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4.6 Probability models

4.6.1 Introduction

The  probability  models  are  responsible  for  calculating  the  W  and  P  matrices  (see  previous
sections)  containing  the  relative  weight  fractions  and  probability  parameters  respectively.  The
probability parameters are derived using Markovian statistics. The rank of the matrices depends on
the number of components “G” in the mixed-layer and the Reichweite “R”. 

The Reichweite  or  Reach  is  an  important  concept.  The value  for  R  denotes  what  number  of
previous components (in a stack of components) still influence the probability determining the type
of the following component. With other words, for:

R=0; the  type  of  the  next  component  does  not  depend  on  the  previous
components,

R=1; the  type  of  the  next  component  depends  on  the  type  of  the  previous
component,

R=2; the type of the next component depends on the types of the previous two
components,

etc.

There  are  a  number  of  general  relations  between the  weight  fractions  W and  probabilities  P
detailed below. They are valid regardless of the value of R or G. These are detailed below. For a
more complete explanation:  see  Drits & Tchoubar (1990).  For stacks composed of  G types of
layers, we can write:

W i=Ni/Nmax where i ∈ {1, 2, …, G}
W ij=Nij /(Nmax−1) where i, j ∈ {1, 2, …, G}
W ijk=Nijk /(Nmax−2) where i, j, k ∈ {1, 2, …, G}

⋮
etc. … …

(eq. box 4.25)

with:
Wij=W i⋅Pij W ijk=W ij⋅Pijk …

∑
i

G

Wi=1     ∑
i

G

∑
j

G

W ij=1 …

∑
j

G

Pij=1 ∑
k

G

Pijk=1 …

(eq. box 4.26)

In the following sections a description is made how to setup the matrices used in the calculations
for  different  combinations  of  R  and  G.  An  important  step  in  this  process  is  the  selection  of
independent parameters. A modeller is free to choose these, however for PyXRD it was chosen to
make the definition of the independent parameters identical to those used in the Sybilla® model
created by the engineers of Chevron, to facilitate (future) exchange of models and comparison of
results. 
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i. W and P matrix layouts

The general expressions for the W and P matrix for different combinations of R and G can be
generalized.  To  illustrate  this,  the  matrices  for  an  R0  or  R1  models  and  for  an  R2  with  G
components model are shown below.

The expressions for the W and P matrix for R0 and R1 models are:

W=[
W1 0 … 0
0 W2 … 0
⋮ ⋮ ⋮
0 0 … WG

] (eq. box 4.27)

P=[
P11 P12 … P1G

P21 P22 … P2G

⋮ ⋮ ⋮
PG1 PG2 … PGG

] (eq. box 4.28)

Observe that these matrices are of size GxG.

For an R2 model, the basic layout is preserved, however each of the elements in the W and P
matrices (e.g. W1 or P11) are replaced by sub-matrices of size GxG:

W i=[
W i1 0 … 0
0 W i2 … 0
⋮ ⋮ ⋮
0 0 … WiG

]
Pij=[

0 0 … 0
0 0 0
⋮ ⋮ ⋮

Pij1 Pij2 … PijG ← j-th row of the matrix
⋮ ⋮ ⋮
0 0 … 0

]
(eq. box 4.29)

This increases the size of the complete W or P matrix to G²xG². 

In general, for a model with a Reichweite R and G components, the final W and P matrix will have
a size of GRxGR. They can be created using the general layout of equations 4.29 and by replacing
the elements recursively G-1 times by sub-matrices of the following generalised form:
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W…=[
W…1 0 … 0

0 W…2 … 0
⋮ ⋮ ⋮
0 0 … W…G

]
P…=[

0 0 … 0
0 0 0
⋮ ⋮ ⋮

P…1 P…2 … P…G ← j-th row of the matrix
⋮ ⋮ ⋮
0 0 … 0

]
(eq. box 4.30)

The “…” indices are to be replaced with the indices of the parameters the sub-matrix is replacing in
the parent matrix. E.g. when replacing the initial W i elements for an R3 model, the “...” index would
be replaced with the value of the “i” index of the replaced W i parameter. The result will be a matrix
containing Wij parameters. Since we are creating a matrix for an R3 model, there need to be in
total 2 rounds of replacements. This means we need to replace every Wij parameter with another
sub-matrix in which the “...” index is this time replaced with the value ij index values of the replaced
Wij parameter. We have then made G-1 recursive replacements and the matrix will have a size of
G3xG3 and contain parameters of the form Wijk.

ii. Parameter and matrix indexation

Simple  relationships  can  be  derived  to  obtain  the  matrix  column  and  row  indexes  from  the
parameter indexes and vice-versa.

W parameter indexes to column and row indexes:

x=y=∑
i=1

Z

zi⋅G
R'−i

(eq. box 4.31)

in which:
x the W matrix column index
y the W matrix row index
Z the number of indexes in the W parameter (e.g. 2 for W11)
zi the value of the i-th W parameter index (e.g. z1 = 2 for W21)
G the number of components
R' R, but with a lower limit of 1, as in: R ':((R>1)→R)∧((R⩽1)→1)

The opposite relation for W parameters is:

z i=(⌊ x−1
GR−i ⌋ mod G)+1 (eq. box 4.32)

in which:
zi the value of the i-th W parameter index (e.g. z1 = 2 for W21)
G the number of components
R' R, but with a lower limit of 1, as in: R ':((R>1)→R)∧((R⩽1)→1)
x the W matrix column index (can be replaced with the row index since x=y)
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P parameter indexes to column and row indexes:

x=∑
i=1

Z−1

zi⋅G
R'−i

y=∑
i=2

Z

zi⋅G
R'−i

(eq. box 4.33)

in which:
Z the number of indexes in the P parameter (e.g. 3 for P123)
zi the value of the i-th W parameter index (e.g. z1 = 3 for P321)
G the number of components
R' R, but with a lower limit of 1, as in: R ':((R>1)→R)∧((R⩽1)→1)
x the P matrix column index
y the P matrix row index

The opposite relation for P parameters is:
for i ∈ {1,2,…,G}

   zi=(⌊ x−1

GR−i
⌋ mod G)+1

for i = G:

   zi=(⌊ y−1
GR−i ⌋ mod G)+1

(eq. box 4.34)

in which:
zi the value of the i-th W parameter index (e.g. z1 = 2 for W21)
G the number of components
R' R, but with a lower limit of 1, as in: R ':((R>1)→R)∧((R⩽1)→1)
x the W matrix column index (can be replaced with the row index since x=y)
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4.6.2 R0 models – random interlayering

In this model the chance of finding any type of layer after another type of layer equals the relative
weight of that layer in the whole stack. This type of dis-order is actually a specific type of R1
ordering where for a stack containing G different types of layers we can write:

Pga=Wa      and     Wga=Wg∗Pga=Wg∗Wa

Pgb=Wb      and     Wgb=Wg∗Pgb=Wg∗Wb

Pgc=Wc      and     Wgb=Wg∗Pgc=Wg∗Wc

...
PgG=WG      and     WgG=Wg∗PgG=Wg∗WG      with g∈ {1,2,…,G}

(eq. box 4.35)

In  addition  to  the above relations,  the  sum of  all  the  relative  weights  should  equal  one (see
equation box 4.26):

∑
i=1

G

Wi=1

Therefore, since we have G weight fraction parameters and we have G+1 relations, we only need
to choose G-1 independent parameters to be able to calculate all  weight fractions and related
probabilities. These G-1 parameters are chosen as such so that they can all be described by the
following weight fraction definition:

Fwg=
Wg

∑
i=g

G

W i

     withg∈{ 1,2,…,G−1 } (eq. box 4.36)

Using the above definition we can derive that:

Wg=Fwg∗∑
i=g

G

Wi       for every g ∈{1, 2, …, G} (eq. box 4.37)

and using equation 4.26, we can also derive that:

∑
i=1

G

W i
⏟

= 1

=∑
i=1

g−1

Wi+∑
i=g

G

W i

∑
i=g

G

Wi=1−∑
i=1

g−1

W i     for every g ∈{1, 2, …, G}

(eq. box 4.38)

If we are considering the first ratio Fw1, then in equation 4.37 g = 1 and, using equation 4.26, can
be written as:

W1=Fw1⋅∑
i=1

G

W i
⏟

= 1

W1=Fw1

(eq. box 4.39)

Or, with other words, the first fraction equals the weight fraction for the first component. Knowing
this, the other weight fractions can be derived in sequence  by combining the relations in boxes
4.37 and 4.38. E.g. for g = 2 we can write:

W2=Fw2⋅∑
i=2

G

W i (eq. box 4.40)
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and since:

∑
i=2

G

Wi=1−∑
i=1

1

W i=1−W1 (eq. box 4.41)

the first expression becomes:

W2=Fw2⋅(1−W1) (eq. box 4.42)

As can be derived from the above  equations,  these  R0 expression can be extended for  any
number of components. In fact, the implementation in PyXRD comprises a generalised probability
model that can handle any number of layers. In practice however, there is little need for a 100
component mixed layer model, so the upper limit has been set to 6 different components (for now).
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4.6.3 R1 models

PyXRD has R1 models available for mixed-layers with up to 4 different components.

i. Two-component R1 model

For two-component (G=2) R1 models, the independent parameters are W1  and P11(if W1⩽0.5)
or P22( if W1>0.5) . The other parameters in this model can then be calculated using these two
parameters:

W2=1−W1

if W0⩽0.5 :
    P12=1−P11

    P21=W1⋅
P12

W2

    P22=1−P21

if W0>0.5 :
    P21=1−P22

    P12=W2⋅
P21

W1

    P11=1−P12

(eq. box 4.43)

ii. Three-component R1 model

For three-component (G=3) R1 models, the first two independent parameters are identical to the
two-component  model:  W1  and  either  P11(if W1⩽0.5)  or  P22( if W1>0.5) .  The  other  four
parameters are chosen to be the following fractions:

Fw1=
W2

W3+W2

Fw2=
W22+W23

W22+W23+W32+W33

Fw3=
W22

W22+W23

Fw4=
W23

W32+W33

(eq. box 4.44)

The primary weight fractions W2 and W3 can be calculated as follows:

W2=(1−W1)⋅Fw1

W3=1−W1−W2

(eq. box 4.45)

Then, if W1 ≤ 0.5, P22 needs to be calculated as follows:

if W2>0.0:

    P22=
Fw2⋅Fw3⋅(W1⋅(P11−1)+W2+W3)

W2

else:
    P22=0

(eq. box 4.46)
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From that point on the calculation is fairly straightforward:
W22=P22⋅W2

W23=W22⋅( 1
Fw3

−1) or if Fw3=0 :   W23=0

W32=Fw4⋅( 1
Fw2

−1)⋅(W22+W23) or if Fw2=0 :   W32=0

W33=W32⋅( 1
Fw 4

−1) or if Fw4=0:   W33=0

P23=
W23

W2

or if W2=0:  P23=0

P21=1−P22−P23

P32=
W32

W3

or if W3=0 :   P32=0

P33=
W33

W3

or if W3=0 :   P33=0

P31=1−P32−P33

P12=
W2−W22−W32

W1

or if W1=0 :  P12=0

P13=
W3−W23−W33

W1

or if W1=0 :  P13=0

P11=1−P12−P13 if W1>0.5elseP11 is given

(eq. box 4.47)

At this point we know all probability parameters Pij . Together with the  primary weight fractions W1,
W2 and W3, it possible to calculate any unknown W ij  using the equations from box 4.26.
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iii. Four-component R1 model

As  with  previous  R1  models,  the  first  two  independent  parameters  are  W1  and  either

P11(if W1⩽0.5)  or  P22( if W1>0.5 ) . The other 10 parameters are chosen to be the following
fractions:

Fw1=
W2

W2+W3+W4

Fw2=
W3

W3+W4

Fw3=
W22+W23+W24

∑
i=2

4

∑
j=2

4

W ij

Fw4=
W32+W33+W34

∑
i=3

4

∑
j=2

4

W ij

  

Fw22=
W22

W22+W23+W24

Fw23=
W23

W23+W24

Fw32=
W32

W32+W33+W34

Fw33=
W33

W33+W34

Fw42=
W42

W42+W43+W 44

Fw43=
W43

W43+W44

(eq. box 4.48)

Again, the primary weight fractions can be easily calculated from these fractions:

W2=(1−W1)⋅Fw1

W3=(1−W1−W2)⋅Fw2

W4=1−W1−W2−W3

(eq. box 4.49)

Then, if W1 ≤ 0.5, P22 needs to be calculated as follows:

W11=W1⋅P11

if W2>0 and Fw1>0 :
    P22=Fw1⋅Fw2⋅(W11−2⋅W1+1)
else:
    P22=0

(eq. box 4.50)

From that point on the calculation is again fairly straightforward:
W22=P22⋅W2

W23=W22⋅( 1
Fw22

−1)⋅Fw23 or if Fw22=0 :  W23=0

W24=W22⋅( 1
Fw22

−1)⋅(1−Fw23) or if Fw22=0 :  W24=0

S3x=W32+W33+W34=( 1
Fw3

−1)⋅(∑i=2

4

W2i)⋅Fw4 or if Fw3=0:  S3x=0

W32=S3x⋅Fw32

W33=(S3x−W32)⋅Fw33

W34=S3x−W32−W33
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S4x=W42+W43+W44=( 1
Fw3

−1)⋅(∑i=2

4

W2i)⋅(1−Fw4) or if Fw3=0 :  S4x=0

W42=S4x⋅Fw42

W43=(S4x−W 42)⋅Fw43

W44=S4x−W42−W43

P23=
W23

W2

or if W2=0:  P23=0

P24=
W24

W2

or if W2=0:  P24=0

P21=1−P22−P23−P24

P32=
W32

W3

or if W3=0 :  P32=0

P33=
W33

W3

or if W3=0 :  P33=0

P34=
W34

W3

or if W3=0 :  P34=0

P31=1−P32−P33−P34

P42=
W42

W4

or if W4=0:  P42=0

P43=
W43

W4

or if W4=0:  P43=0

P44=
W44

W4

or if W4=0:  P44=0

P41=1−P42−P43−P44

P12=
W2−W22−W32−W42

W1

or if W1=0 :  P12=0

P13=
W3−W23−W33−W43

W1

or if W1=0 :  P13=0

P14=
W4−W24−W34−W44

W1

or if W1=0 :  P14=0

P11=1−P12−P13−P14 if W1>0.5elseP11 is given

(eq. box 4.51)

At this point we know all probability parameters Pij . Together with the  primary weight fractions W1,
W2, W3 and W4, it possible to calculate any unknown W ij  using the equations from box 4.26.
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4.6.4 R2 models

PyXRD has R2 models available for models with up to 3 different components.

i. Two-component R2 model

This is one of the few exceptions where the choice of independent parameters differs from Sybilla.
The  reason  is  that  Sybilla  implements  a  restricted  version,  not  allowing  for  the  full  range  of
possibilities. PyXRD does not have these constraints. The result is that PyXRD requires two more
parameters (4 in tolal) compared with Sybilla.
As with previous models, the first independent parameter is W1  and either P112(if W1⩽2/3)  or

P211(if W1>2/3) , P21  and either P122(if W1⩽0.5)  or P211(if W1>0.5) .

The calculation proceeds as follows:

W2=1−W1

P22=1−P21

W21=W2⋅P21

W22=W2⋅P22

W12=W21

W11=W1−W21

If W1⩽2/3 :

   P211=P112⋅
W11

W21

else:

   P112=P211⋅
W21

W11

P212=1−P211

P111=1−P112

If W1⩽0.5:

   P221=P211⋅
W12

W22

else:

   P122=P221⋅
W22

W12

P121=1−P122

P222=1−P221

(eq. box 4.52)

ii. Three-component   R2 model

The three-component  R2  model  is  restricted in  the  sense  that  the  weight  fraction  of  the  first
component must be equal to or larger then 50% and no 2nd or 3d type component can follow or
precede another 2nd or 3d type component. This restriction results into the following relations:

P22=P23=0 ⇒ P21=1
P32=P33=0 ⇒ P31=1

P222=P223=0 ⇒ P221=1
P232=P233=0 ⇒ P231=1
P322=P323=0 ⇒ P321=1
P332=P333=0 ⇒ P331=1

W21=W12=W2

W31=W13=W3

W11=W1

(eq. box 4.53)

Because of these restrictions, the number of independent variables is reduced to only 6. They are
chosen to be W1 , either P111(if 0.5⩽W1⩽2/3)  or P212(if 2/3⩽W1⩽1) , and the following four
fractions:
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Fw1=
W1

W1+W2

Fw2=
W212+W213

W212+W213+W312+W313

Fw3=
W212

W212+W213

Fw4=
W312

W312+W313

 (eq. box 4.54)

The calculation of the other parameters proceeds as follows:
W2=Fw1⋅(1−W1)

W3=1−W1−W2

P212=
Fw2⋅Fw1

W1

⋅[W11⋅(P111−1)+2] if 0.5⩽W1⩽2 /3

P213=P212⋅(
1

Fw3

−1) or if Fw3=0 ⇒ P213=1

W212=P212⋅W21=P212⋅W2

W213=P213⋅W2

W211=1−W212−W213

W312+W313=
1−Fw2

Fw3⋅Fw4

⋅W212    or if Fw3=0 or Fw4=0 ⇒ W312+W313=0

W312=Fw4⋅(W312+W313)

W313=(
1

Fw4

−1)⋅W312   or if Fw 4=0 ⇒ W313=1

W311=1−W312−W313

W111=W11−W211−W311

The remaining unknown parameters can be derived using the general equations as in equations
4.25 and 4.26.
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4.6.5 R3 models

PyXRD has a single (restricted) R3 probability model built-in for a 2 component mixed layer.

Because of  the restrictions only 2 independent  variables are needed for  this model;  W1  and

P1111(if 2/3⩽W1<3 /4)  or P2112(if 3/4⩽W1⩽1) .

The restrictions for this model, that: 

– only mixed layers with more than  2/3 of the first layer type can be described

– no two layers of the second type occur after each other

– the probability of finding a layer of the first type in between two layers of the second type is
zero

This translates into the following conditions:

2/3⩽W1⩽1
P22=P212=0
P21=P211=1

The probabilities below are undefined  but are set to zero or one to make the matrix valid. The
actual value actually has no meaning since the weight fractions they should be multiplied with
equal zero anyway (e.g. W2211=W22⋅P221⋅P2211  and W22  is zero since P22  is zero):

P1121=P1211=P2211=P2121=P2221=P1221=0
P1122=P1212=P2212=P2122=P2222=P1222=1

The remaining probabilities and weight fractions can be calculated as follows and using equations
4.25 and 4.26:

W2=1−W1

if W1<3/4  :
P1111 is given
P1112=1−P1111

P2111=P1112⋅
W1−2⋅W2

W2

P2112=1−P2111

if W1⩾3/4  :
P2112 is given
P2111=1−P2112

P1111=P2111⋅
W2

W1−2⋅W2

P1112=1−P1111

W111=3⋅W1−2
W212=W221=W222=W122=0
W211=W121=W112=1−W1
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5 Software layout

The general software layout of PyXRD is schematically presented in Figure 1. 

The  most  basic  layer  is  inside  the  'calculations'  module.  This  module  contains  all  the  basic
functions and data structures to allow fast calculations of X-ray diffraction patterns of disordered
lamellar structures. In effect it is an implementation of the matrix algorithm as presented in the
previous chapters. However, this layer is too basic to be of immediate use to a non-technical user.
A GUI has been created to allow easier manipulation of objects. This is where the mvc framework
comes into play.

The mvc framework consists of three layers: a model layer containing all the 'logic' and wrapping
the data  structures  present  in  the  calculation  layer.  On top of  this  layer  two  more layers  are
provided: a controller and a view. The view is the visual representation of a (or part of a) model(s)
while the controller provides the link between that view and the underlying model(s).  The mvc
pattern is a common paradigm which allows to separate so-called 'business logic' aspects from
GUI aspects, making it easier to debug these separately.

In the PyXRD source tree the models, views and controllers are grouped topic-wise, meaning that
all views, controllers and models for a specific part (e.g. atoms, projects, phases, …) are grouped
in a module named accordingly. Common code is provided by the mvc module. In future releases
the mvc module might become a separate dependency. For now it is included with PyXRD. 

The actual calculations (as presented in the previous chapters) are fully separated from the model
layer into the calculations module. This makes it easier to spread the calculations over several
processes, making efficient use of multi-core processors.

Aside from these layers, there are (more technical) aspects which are not covered in this manual
like input/output, plotting, refinement support, etc. For details on these we refer to the source code
and the documentation therein. 
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5.1 Model hierarchy

5.1.1 Overview

An overview of the model hierarchy can be found in Figure 2. The topmost model is the Project,
which holds references to AtomTypes, Phases, Specimens and Mixtures. Each of these can have
references to each other and several other objects each of which are discussed in more detail
below.

5.1.2 AtomTypes and Atoms

The most basic building block is the AtomType. This object bundles all the physical constants (e.g.
charge, atomic weight, scattering factors, ...)  for a single ion (e.g. Fe2+, Fe3+, …) or for a small
enough  molecule  (i.e.  H2O or  glycol).  When  a  new project  is  created  a  default  list  of  these
AtomTypes is loaded, using the atomic scattering factors as published in (Waasmaier and Kirfel,
1995).

Atom objects hold a reference to one of these AtomTypes and has additional information about the
position of that atom in the structure (a z coordinate) and its multiplicity (as atoms are projected,
we can group them together). Lists of these atom objects are used in the Component object to
describe  the  layers  and  interlayers.  They also  support  expendable  interlayers  in  which  the  z
coordinate of the Atom is recalculated keeping the relative alignment correct.

5.1.3 Phases, Components, AtomRelations and UnitCellProperties

Phase objects contain all the information needed to calculate a one-dimensional X-ray diffraction
pattern for a (mixed-layer) mineral. A Phase is built out of (i) a  Probability object, (ii) an object
describing the coherent scattering domain size (CSDS) and (iii) one or more Component objects
which describe the different types of layers in the  Phase. The  Probability object describes how
these layers are stacked using Markovian statistics and the Reichweite concept as detailed in
chapter 4.6. The CSDS object describes what type of coherent scattering domain size distribution
should be used and contains the necessary parameter values (e.g. average CSDS). Currently two
types are implemented: a generic log-normal distribution and a log-normal distribution in which the
average  values  published  in  Drits  et  al.  (1997)  are  used  and  the average  CSDS is  the  only
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variable.  Each  phase  also  has  a  σ* factor  which  allows  to  correct  for  incomplete  preferred
orientation (see chapter 4.5).

Component objects describe the size, structure, composition and (variation in) basal spacing for
each layer  type  in  that  phase.  A  Component contains  two lists  of  Atom objects.  The first  list
contains  atoms in the silicate lattice while the other list contains the variable interlayer ions. This
way, the silicate structure can be shared between different phases (e.g. AD and EG states) while
keeping the interlayer contents separate. It also allows to automatically adjust the positions of the
interlayer  content  in  function  of  the  basal  spacing,  as  the  size  of  the  silicate  lattice  can  be
determined and be used as a reference plane for scaling the interlayer atom positions.

Inside Components one can also define several AtomRelations: these describe relations between
atoms.  One  such  relation  are  AtomRatio's,  for  example  the  octahedral  composition  of  a
dioctahedral clay mineral can be expressed as the ratio of iron atoms over the sum of iron and
aluminium atoms in that octahedral position. The  AtomRatio object will then make sure that the
sum of both Atoms multiplicity is always 4, and that their relative amounts is controlled by a certain
ratio set by the user. Both the value of the sum and the ratio can be adjusted. Another example is
interlayer cation contents, which are controlled by an AtomContents object.

Another type of  AtomRelation are  UnitCellProperties.  These objects describe the b and c axis
length of the unti cell. This object is needed, since these properties are inter-dependent (i.e. the b-
length  can  be  calculated  if  the  c-length  is  known  and  vice-versa)  and  dependent  on  the
composition (e.g. the octahedral iron content). A  UnitCellProperty object allows to define these
simple mathematical relations, making the adjustment of the unit cell size automatic.
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5.1.4 Specimens, Mixture and Projects

Specimen objects  contain  all  the  information  regarding  the  experimental  data  (the  actual
measurements, sample size, etc.) and the Goniometer  set up (radius, slit sizes, etc.). They also
have a bunch of visual settings (e.g. linwidth, line color, wether to display phase profiles separately,
…) and import/export functionality.
Maybe slightly counter-intuitive, they do not hold a direct reference to phases, but are linked with
them using Mixture objects.

Mixture objects link phases and specimens together. To visualize this, in the user interface, a table
is created with just as many rows as there are Phases in the Mixture and just as many columns as
there are  Specimens  in the  Mixture. At the column headers there are slots where the user can
select the  Specimen  and in each cell of the grid there are slots where the user can select the
corresponding Phase. This allows to select different states of smectite for an AD and an EG pattern
loaded in  a  Specimen  (Figure  3),  while  keeping  unaffected  Phases,  like  kaolinites  and  micas
identical.

Once a  Mixture  is created a number of parameters are available for automatic refinement (e.g.
weight fractions from the Probability object, the average CSDS, etc.). In the refinement dialog, the
user can select which parameters it would like to improve and in between which minimum and
maximum values the ideal value should be searched for. A number of different refinement methods
are available for this purpose.

As mentioned, Project  objects group together all  Mixtures,  Specimens, Phases and  AtomTypes
and provides a way to store and (re)load these Projects.
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Figure  3:  screenshot  showing  the  'Edit  Mixtures'  dialog  where  a  user  can  link  different  phases
(Kaolinite, Illite, ISS R0 Ca-AD, ...) with the corresponding specimen (S1AD.dat, S1EG.dat).



6 GUI screenshot flowchart



7 Guided example

7.1 Installing DEAP (optional)

DEAP is  a python library PyXRD uses for its genetic refinement algorithms. These are much more
robust then the default algorithms PyXRD provides. 

To install DEAP in Windows:

• Open a command line as administrator (Start button → Search for “cmd” → Right click and
select “Run as Administrator”)

• In the command line type the following:
C:\Python27\Scripts\easy_install.exe deap

7.2 Instructions

This short example will  guide through creating a simple project for phase refinement. It uses a
calculated pattern as 'experimental data' so you can be sure everything has been set-up the way it
should be.

The input files needed can be found online:

• http://users.ugent.be/~madumon/pyxrd/simple/S1AD.dat

• http://users.ugent.be/~madumon/pyxrd/simple/S1EG.dat

7.2.1 Creating a project and loading data

1. Get the two files above and store them somewhere you'll find them again.

2. Launch PyXRD

3. Create a new project by going to Project → New Project in the menu. An Edit Project dialog
will appear where you can fill in some metadata or leave them as they are.

4. By  default,  PyXRD  runs  in "View  Mode" which  means  it  hides  all  the  user  interface
elements that allow quantitative analysis. Change the layout mode to 'Full' at the dropdown
box at the bottom of the Edit Project dialog.

5. Import the 2 patterns you downloaded:

◦ Right-click in the specimens list on the left of the main window (indicated in red in
the screenshot flowchart)

◦ Select Import Specimens from the drop-down menu

◦ Browse to the 2 files you downloaded.

◦ Select both files and click Ok

7.2.2 Goniometer settings

Now that we have loaded our data we still need to check if the Goniometer settings are correct. To
do this:

1. Select the first specimen, right click it and select Edit Specimen from the pop-up menu.

2. In the Edit Specimen dialog select the Goniometer tab.
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3. Load the default “Philips X'PERT PW3710 Cu” goniometer setyp by selecting the correct
item in the 'Load Setup' dropdown box at the bottom of the Edit Specimen dialog.

That's it, you've correctly setup the Goniometer for this example. For your own data you need to
adjust the values to match your XRD goniometer setup. 

7.2.3 Adding phases

Have a good look at those patterns and notice there are probably 3 phases in there: kaolinite,
something like a mica and something like a smectite. Let's add these 3 phases and see if this
works:

1. Open the Edit Phases dialog by clicking the corresponding icon in the toolbar or by going to
Data → Edit Phases in the menu.

2. At the bottom of the phases list click the Add button.

Note:  If  this  is  the  first  time  you're  adding  Phases,  no  default  Phases  are  available.
However, they can be generated by clicking the reload button on the bottom right (having a
" " sign on it).This takes a few minutes. ↻

3. Select the following phases one-by-one, from the list of default phases:

• Kaolinite

• Illite

• (dioctahedral) ISS R0 Ca (= Illite-Smectite)

Default phases can be found in the dropdown box at the bottom.

If all went well you should have a list of 5 phases: the kaolinite and illite and 3 states of ISS R0: air-
dry, ethylene-glycolated and heated.

7.2.4 Creating mixtures

The next step is to create a mixture where we link the 2 loaded patterns with the 3 added phases.

1. Click the Edit Mixtures button in the toolbar or go to Data → Edit Mixtures in the menu.

2. In the Edit Mixtures dialog, add a new mixture by clicking the 'Add' button at the bottom of
the list on the left. Select the new mixture in the list.

3. After  selecting  your  mixture,  its  properties  should appear  in  the right  pane of  the  'Edit
Mixtures' dialog:

• Give it a proper name by editing the 'Mixture name' field at the top, e.g. "Mixture
S1".

• In the 'Setup' section, you can notice three buttons:

◦ one at the bottom with a downwards-pointing arrow,

◦ one on the right side with a rightwards-pointing arrow and

◦ one in the bottom right corner with a "+" icon.

These buttons can be used to add a phase, specimens or both at the same time
respectively, so:

◦ Click the phase button (bottom one) 3 times (once for each phase we want to
add). 
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◦ Then  click  the  specimen  button  twice (once  for  each  diffraction  pattern  or
specimen).

4. On the line saying 'Specimens', select the air-dry and glycolated patterns in the first and
second dropdown box respectively.

5. For each 'New Phase' line, change the name text input and dropdown boxes as follows:

Name input: Air-dry column phase dropdown: Glycolated phase dropdown:

Kaolinite Kaolinite Kaolinite

Illite Illite Illite

ISS R0 ISS R0 Ca AD ISS R0 Ca EG

6. Finally, check the checkbox next to the Optimize button, so PyXRD will automatically adjust
the contents of your phases to the best fit.

7. Your final Edit Mixtures dialog should look something like this:

8. To update your calculated patterns, press the Optimize button. Then make sure you have
selected both specimens (in the main window) and check for the presence of a black line
(experimental data) and a red line (calculated data) in the plot area.
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7.2.5 Refine some parameters

As you will have noticed, the calculated pattern does not really fit the experimental pattern that
well. We can try to improve the fit by adjusting some of the parameters:

1. If you've closed the Edit Mixtures dialog, re-open it

2. Click the 'Refine' button in the 'Edit Mixtures' dialog. A Refine Phase Parameters dialog will
appear.

3. For this simple example, 3 parameters were changed in the ISS R0 phase. So we're going
to set up our refinement strategy for these 3 parameters alone:

◦ Click the arrow next to the 'ISS R0 Ca-AD' entry to unfold the options for this phase.
Then check the 'Refine' box for the following parameters:

• Average CSDS

• And under Probabilities:

◦ W1 / ∑1-3(Wi)

◦ W2 / ∑2-3(Wi)

◦ For the 'Average CSDS' it is also best to change the maximum value to 10.

4. Change the algorithm to  CMA-ES refinement if  you've installed DEAP,  and change the
number of generations to 30. Otherwise leave at L BFGS B.

5. After these changes your dialog should look something like this:

6. Finally, click  the  Refine button and  wait  for  the  computer  to  finish  its  calculation. 
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If successful, the refinement should end up close to these values:

• Average CSDS = 5

• Probabilities:

◦ W1 / ∑1-3(Wi) = 0.1

◦ W2 / ∑2-3(Wi) = 0.5

When  closing  the  refinement  dialog,  you  can  also  check  if  the  phases  are  given  weight
percentages in  a 1:1:1 ratio.  Check this  by closing the 'Refine Phase Parameters'  dialog and
clicking the 'Optimize' and 'Apply'  buttons in the 'Edit  Mixtures' dialog. After that the 'Fractions'
column should have (near-to-)equal proportions for each phase.

That's it, you have used PyXRD succesfully for the first time!
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